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Copyright 

This manual and the product and programs it describes are 
protected by copyright laws and therefore may not be 
reproduced in whole or in part, whether for sale or not, 
without written consent from Mediatrix Peripherals Inc.  
Under copyright law, copying includes translation into 
another language or format.   

The purchaser may use the programs on any computer in his 
or her possession, but only on one computer at a time.   

Audiotrix is a trademark of Mediatrix Peripherals Inc.  Ad Lib 
is a registered trademark of Ad Lib Multimedia Inc.  Sound 
Blaster is a trademark of Creative Labs, Inc.  IBM PC, and AT 
are registered trademarks of International Business Machines 
Corporation.  MS-DOS, Windows and Microsoft are 
registered trademarks of Microsoft Corporation.   

Limited Warranty 

Mediatrix Peripherals Inc. warrants the Audiotrix Pro 
professional sound board to be free of any defects in 
materials or workmanship for a period of twelve (12) months 
from the date of purchase.  Mediatrix Peripherals Inc. 
warrants Audiotrix Pro software programs to be free of any 
defects in material or workmanship for a period of ninety 
(90) days from the date of purchase.  These warranties are 
limited to the original purchaser of the product and are not 
transferable.   

Mediatrix Peripherals Inc. will refund, repair or replace any 
product component or documentation, at its option and at no 
additional charge, if found defective within the warranty 
period.  The purchaser is responsible for returning the 
product to Mediatrix Peripherals Inc., and must provide a 
dated proof-of-purchase and/or have a registered warranty 
card for said product on file with Mediatrix Peripherals Inc.   
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Mediatrix Peripherals Inc. will not be held responsible in any 
way whatsoever for damage resulting from improper 
installation, accident, misuse, or from service or 
modification of the product by anyone other than Mediatrix 
Peripherals Inc. or an authorized Audiotrix service center.   

Mediatrix Peripherals Inc. will not be held responsible in any 
way whatsoever for direct, indirect, special, incidental, or 
consequential damages resulting from possession, use, 
improper installation, accident, service, modification or 
malfunction of the product.   

This warranty is in lieu of all other warranties, whether oral, 
written, expressed or implied, including any warranty of 
merchantability or fitness for a particular purpose, and no 
other representation or claims of any nature shall be binding 
on or obligate Mediatrix Peripherals Inc.   

This warranty gives you specific legal rights.  You may have 
other rights according to your place of residence.   

Warning 

This equipment generates and uses radio frequency energy, 
and if not installed and used properly (i.e. in strict accordance 
with the manufacturer’s instructions), may cause interference 
to radio and television reception.  It has been tested and found 
to comply with the limits for a Class B device in accordance 
with the specifications in Subpart B of Part 15 of FCC Rules, 
which are designed to provide reasonable protection against 
such interference in a residential installation.   

The user is cautioned that changes or modifications not 
expressly approved by Mediatrix, could void the user’s 
authority to operate this equipment. 

This device complies with Part 15 of the FCC Rules.  
Operation is subject to the following two conditions:   
(1) this device may not cause harmful interference, and  
(2) this device must accept any interference received,  
including interference that may cause undesired operation.   
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Only peripherals (computer input/output devices, terminals, 
printers, etc.) certified to comply with the class B limits may 
be attached to this equipment.  Operation with non-certified 
peripherals is likely to result in interference to radio and TV 
reception.  Furthermore, the use of a non-shielded I/O cable 
with this device will not enable the device to meet the 
minimum emission limits mandated by U.S. federal law.   

There is no guarantee that interference will not occur in a 
particular installation.  If this equipment does cause 
interference to radio or television reception (this can be 
determined by turning the equipment off and on), the user is 
encouraged to try to correct the interference by one or more 
of the following measures:  

• Reorient the receiving antenna.   

• Move the computer away from the receiver.   

• Plug the computer into a different outlet so that 
computer and receiver are on different branch 
circuits.   

If necessary, the user should consult the dealer or an 
experienced radio/television technician for additional 
suggestions.  The user is hereby notified that changes or 
modifications not expressly approved by Mediatrix 
Peripherals Inc. could void the user's rights under the limited 
warranty.   

The user may find it helpful to consult the booklet:  
“How to Identify and Resolve Radio-TV Interference 
Problems,” prepared by the Federal Communications 
Commission.  This booklet is available from the U.S.  
Government Printing Office, Washington, DC 20402, Stock 
No. 004-000-00345-4.   
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Technical Support 

Mediatrix Peripherals Inc. is firmly committed to providing 
the highest level of customer service and product support.  If 
you experience any difficulties when using our product, or if 
it fails to operate as described, we suggest you first consult 
the User’s Guide, and then, if you are still in need of 
assistance, call our Technical Support Department:  

• Telephone: (819) 829-TRIX 

   (800) 820-TRIX 

• Hours, Monday to Friday:  

• North American Eastern Time:  
9:00 a.m. to 5:00 p.m. 

• Fax:  (819) 829-5100 

• BBS: (819) 829-5101 

Notice 

Mediatrix Peripherals Inc. reserves the right to make changes 
or improvements in the product described in this manual at 
any time and without notice.   

WARNING: Your Audiotrix Pro sound board is packaged 
in a special plastic clamshell designed to protect it against 
static electricity.  We recommend that you keep it in this 
package until you are ready to install it in your computer.  
Electronic boards can be easily damaged with static 
electricity and must be handled with care.  Users should 
ground themselves before handling the card.  Please read 
the User’s Guide before beginning installation.   
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                                    IMPORTANT 
 
Before reading this User’s Guide and returning your 
registration card, please note below the serial number of your 
Audiotrix Pro card (which can be found on the back of the 
card), the version number of the Audiotrix Pro software 
(which can be found on the Audiotrix Pro Program Disks), 
and the date of purchase.  This information will be needed 
when calling for service.  
 
Serial Number _________________________________  
 
Software Version _______________________________  
 
Date Purchased ________________________________  
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Mediatrix Peripherals Inc. 
4229 Garlock Street 
Sherbrooke, Québec, Canada  J1L 2C8 
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Introduction 

Wavetable & FM Synthesis Break the Sound 
Barrier 

The audio performance standard for the PC has been raised 
again with the introduction of the Audiotrix Pro.  This brand 
new sound card is based on the Yamaha OPL4 chip set which 
contains Wavetable and FM synthesis.  Wavetable synthesis is 
based on the digitized recordings of actual instrument sounds 
while FM synthesis is based on the manipulation of sine 
waves.  The Audiotrix Pro permits 24 voices of Wavetable 
sound and 20 voices of FM sound to be output 
simultaneously.  The result is a new height in audio 
performance that has no equal in the PC marketplace today!   

The Audiotrix Pro 

In addition to Wavetable and FM synthesis the Audiotrix Pro 
also features:  

• A standard general MIDI voice bank on a 2 megabyte 
mask ROM.   

• A 16-bit audio codec which provides a complete 
MPC and Microsoft Windows Sound System solution 
while remaining backward compatible with the 
original industry standards Ad Lib and Sound Blaster.   

• An optional Effects Processor is also available as a 
daughter board to the Audiotrix Pro which provides 
even higher quality sound with the addition of such 
effects as echo, reverb, flange, distortion, panning and 
surround processing.   
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The Manual 

This manual describes Audiotrix Pro hardware and 
installation, and explains how to use the software included to 
help you get the most out of your audio adapter.  Be sure to 
read the sections on:  

• Mixer utilities, which controls mixing functions such 
as volume and balance of the various audio sources.   

• Jukebox, a music playback program that includes a 
music clip library in a variety of styles, and that lets 
you listen to songs you want from standard MIDI 
files, wave files and CD tracks.   

• PLAYMIDI, a utility program used for playing back 
MIDI files from the DOS command line or from a 
batch file.   

• PLAYWAVE, a utility program used for playing back 
digitized sound files from the DOS command line or 
from a batch file.   

The Bottom Line 

You’ll quickly come to appreciate Audiotrix Pro for its 
unrivalled quality, flexibility and usefulness.  For complete 
information on Mediatrix products, call us today on our 
customer service line at (800) 820-TRIX, or write 
Mediatrix Peripherals Inc., 4229 Garlock Street, Sherbrooke, 
Québec, Canada  J1L 2C8.   
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Chapter 1 

Quick Start 
This Quick Start is intended for the experienced PC user who 
has already installed and used various hardware devices and 
software applications.  Do not attempt a quick start 
installation if you are not familiar with the PC environment; 
installation errors could occur that will be difficult to correct 
afterwards.  This Quick Start includes references to the 
User’s Guide for those who need complete information on a 
particular hardware or software installation step.   

Installing the Hardware 

Installing the hardware involves two main steps:  

• Install the Audiotrix Pro Card 

• Connect the Other Peripherals 

Install the Audiotrix Pro 
1. Make sure that the on-board jumpers — the joystick 

selector jumpers and the microphone selector 
jumpers, are in the desired position.   

q See “Description of the Audiotrix Pro Card: Layout 
of the Card,” and “Getting Installed: Hardware 
Installation.”   

2. Plug the Audiotrix Pro card into the computer in a 
free slot as far as possible from the video adapter 
card.   

NOTE:  Certain cards, such as video adapters, 
produce high-frequency signals that can interfere with 
the sound quality of the sound card.   
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q See “Getting Installed: Hardware Installation.”   

Connect the Other Peripherals 

• Plug external speakers into the main audio output of 
the card, or connect the output to the input of a stereo 
system.   

• Connect a low impedance dynamic microphone, or an 
electret microphone, to the microphone input of the 
card (making sure that the microphone selector 
jumpers are in the position corresponding to the 
microphone).   

• Connect the output of the stereo source (CD player, 
CD-ROM drive, synthesizer or cassette player) to the 
stereo auxiliary input of the card, using a stereo cable.   

• Connect your joystick to the DB-15 game port of the 
card.  If you plan to use the MIDI interface, connect 
your MIDI device with the Audiotrix adapter cable.   

q See “Getting Installed: Hardware Installation.”   

Installing the Software 

Installing the software involves two main steps:  

• Install the Setup Disk 

• Install Audiotrix Applications and other bundled 
programs 

Install the Setup Disk 

When you begin the installation procedure, a text file 
(INSTALL.TXT) is displayed on the screen.  Read this file 
carefully and refer to it later, if necessary.  Another text file 
(README.TXT) is also included on the Setup Disk.  This file  

Chapter 1  Quick Start 
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contains a list of all files copied to your hard disk during the 
installation procedure. 

• Insert the Setup Disk into the floppy drive, set the 
current drive to A (or B, depending on which drive 
you are using), and type the following command:  

A:\>INSTALL 

Install Audiotrix Applications and other Bundled 
Programs 

To install any of the other applications included with the 
Audiotrix Pro, follow the instructions listed on each diskette 
label and read very carefully the additional instructions that 
will be displayed on the screen. 

Using the Audiotrix Pro 

The Audiotrix Pro can be used for:  

• Running Audiotrix Applications 

• Running Third Party Applications 

Running Audiotrix Applications 

Once the Audiotrix hardware and software are installed, you 
can run an Audiotrix application by proceeding as follows:  

1. Set the current directory to the one where you 
placed the Audiotrix programs during the installation 
process.  For the DOS applications, type the 
following command:  

C:\>CD \TRXPRO\DOS 

Installing the Software 
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2. Run the Audiotrix application you want by typing the 
corresponding command 

• To run Jukebox, a program used for playing back 
MIDI files and wave files, type: 

C:\TRXPRO\DOS>JUKEPRO 

 or choose the following icon under Windows:  

• To run PLAYMIDI, a utility used for playing back 
MIDI files in DOS, type:  

PLAYMIDI <FileName>.MID 

 from the C:\TRXPRO\DOS prompt, where 
<FileName> is the complete name of the MIDI 
file (including drive and path) to be played, i.e.: 

PLAYMIDI C:\TRXPRO\MIDI\BLUES.MID 

• To run PLAYWAVE, a utility used for playing 
back digitized sound files in DOS, type:  

PLAYWAVE <FileName>.WAV 

 from the C:\TRXPRO\DOS prompt, where 
<FileName> is the complete name (including 
drive and path) of the digitized sound file (.WAV) 
to be played, i.e.: 

PLAYWAVE C:\TRXPRO\WAVE\INTRO.WAV 

Chapter 1  Quick Start 
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Running Third Party Applications 

To run a third party application supporting the Audiotrix Pro 
card, proceed as follows:  

1. Make sure the Audiotrix hardware and software are 
correctly installed and working properly.   

2. Install the third party application or game according 
to the manufacturer’s instructions.  Make sure you 
choose Audiotrix or Sound Blaster as the sound 
board in the installation options, if requested.   

3. Load the third party application or game by typing 
the appropriate command. 

Using the Audiotrix Pro Card 
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Chapter 2 

Description of the  
Audiotrix Pro 

Functionality 

Your Audiotrix Pro is a multifunction card with digital 
recording, playback of digitized and synthesized sounds, 
analog audio mixing, MIDI recording and playback, game 
port, and SCSI/CD-ROM through an optional add-on 
interface.   

Digital Recording 

With the Audiotrix Pro, you can record from:  

• A low impedance dynamic microphone, or an electret 
microphone 

• An audio tape or a compact disk.   

Digitized and Synthesized Sound Playback 
With the Audiotrix Pro card, you can playback:  

• Digitized sounds: The Audiotrix Pro card has two 
channels for digitized sounds. These channels can be 
used for recording and playing back wave files in a 
variety of ways.   

• Synthesized sounds: The Audiotrix Pro card has a 
20-voice FM and 24-voice Wavetable  
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 synthesizer, which is used for Jukebox and 
PLAYMIDI songs, as well as third party software.   

Analog Audio Mixing 

The sound capabilities of the Audiotrix Pro also feature:  

• Audio mixing: The internal analog mixer of the 
Audiotrix Pro card controls the volume of various 
audio sources, through software, such as within third 
party applications, or manually using the Audiotrix 
Mixer utilities.   

• Volume control: The output volume of the Audiotrix 
Pro card is software controlled.   

• Full compatibility: A 16-bit audio codec provides a 
complete MPC and Microsoft Windows Sound 
System solution, while remaining backward 
compatible with the original industry standards Ad Lib 
and Sound Blaster.   

MIDI Recording and Playback 

The MIDI interface of the Audiotrix Pro allows standard 
MIDI files to be recorded using a MIDI adapter cable and any 
external MIDI instrument.  MIDI files can also be played back 
using any of the several MIDI utilities bundled with the 
Audiotrix Pro. 

Game Port 

The Audiotrix Pro allows a standard IBM compatible joystick 
to be connected.   

Chapter 2  Description of the Audiotrix Pro 
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SCSI Interface 

The Audiotrix Pro has on-board connectors for adding an 
optional SCSI interface, which allows a CD-ROM drive or 
any SCSI (Small Computer System Interface) type peripheral 
to be connected.   

Layout of the Audiotrix Pro 
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Figure 1.  Audiotrix Pro Diagram 

1. Internal stereo auxiliary input 
2. Bracket 
3. Low impedance dynamic microphone/electret microphone  
 input (mono) 
4. Stereo auxiliary input 
5. Main audio output 
6. Game port/MIDI connector 
7. Joystick selector jumpers 
8. Microphone selector jumpers 
9. Sampling chip 
10. OPL4 chip 
11. SCSI module connectors 
12. Wave Table RAM/ROM module connectors 
13. Sound effects module connectors 

Layout of the Audiotrix Pro 
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Bracket Connectors 

Audiotrix Pro has three 1/8" connectors and one DB-15 
connector on the support brackets, as shown on the diagram 
(Figure 1, page 11).   

These connectors are:  

• The low impedance dynamic microphone/electret 
microphone input (Figure 1, No. 3, page 11), for 
sampling and/or mixing with other audio sources.   

• The stereo auxiliary input (Figure 1, No. 4, page 11), 
for connecting an external source such as a CD or 
cassette player, a synthesizer or any audio source, in 
order to sample and/or mix with other audio sources.   

• The main stereo audio output (Figure 1, No. 5, 
page 11), for connecting to loudspeakers, standard 
headphones or a stereo system.   

• The Game Port/MIDI connector (Figure 1, No. 6, 
page 11), for using a standard PC joystick and/or a 
MIDI device. This requires an optional MIDI cable 
adapter available from Mediatrix.   

On-board Connectors and Main Components 

The Audiotrix Pro card has on-board connectors to support 
exciting options to stretch the limits of PC sound even 
further.  These connectors are shown on the diagram 
(Figure 1, page 11).   

Chapter 2  Description of the Audiotrix Pro 
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These connectors are:  

• The SCSI module connectors (Figure 1, No. 11, 
page 11), to snap on SCSI and other proprietary 
CD-ROM interface daughter boards.   

• The Wavetable RAM/ROM module connectors 
(Figure 1, No. 12, page 11), to snap on an additional 
RAM/ROM daughter board to download special 
sounds for custom sound processing.   

• The sound effects module connectors (Figure 1, 
No. 13, page 11), to snap on an Effects Processor 
daughter board.  This module provides echo, reverb, 
flange, distortion, panning, chorus, pitch, and 
surround sound processing.   

• The karaoke effects module.  This can be used in 
place of the sound effects module noted above. 

The On-board Jumpers 
To make it easier to configure the Audiotrix Pro, we have 
made the Interrupt lines (IRQ) and Direct Memory Access 
(DMA) channels software selectable.  The two remaining 
jumpers set are the joystick selector jumpers, and the 
microphone selector jumpers.   

Layout of the Audiotrix Pro 



14 

Joystick Selector Jumpers 

The joystick selector jumpers (Figure 1, No. 7, page 11) let 
the user change the factory-set “dual joystick without MIDI” 
option (all jumper pins  1–2) to the “single joystick with 
MIDI” option (all jumper pins  2–3).  All jumpers in this 
selector must be changed to the same position, as shown in 
the following illustrations.  The “dual joystick without MIDI” 
option is the preferred option even if you only have a single 
joystick, so long as you do not use any MIDI device. 

  
Dual joystick without MIDI Single joystick with MIDI 
(factory-set) option  option 

Figure 2.  Joystick Jumper Selection 

Chapter 2  Description of the Audiotrix Pro  
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Microphone Selector Jumpers 

The microphone selector jumpers (No. 8) let the user change 
the factory-set “low impedance dynamic microphone” option 
(all jumper pins  2–3) to the “electret microphone” option 
(all jumper pins  1–2).  The two jumpers in this selector must 
be changed to the same position, as shown in the following 
illustrations.   

  
Low impedance dynamic microphone Electret microphone 
(factory-set) option  option 

Figure 3.  Microphone Jumper Selection 

WARNING:  Do not change the microphone selector 
jumpers to the “electret microphone” option (all jumpers 
on pins No. 1–2) if you plan to use a standard dynamic 
microphone.  In the “electret microphone” option, the 
microphone input connector supplies a current which 
could damage a non-electret type microphone.  On the 
other hand, if you leave the microphone selector jumpers in 
the “low impedance dynamic microphone” option (all 
jumpers on pins No. 2–3), an electret type microphone will 
simply not work.   

Layout of the Audiotrix Pro 
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Available Interrupt Lines and DMA Channels 

• There are eight software selectable interrupt lines: 
IRQ 3, 4, 5, 7 10, 11, 12, and 15.   

• DMA channels 0, 1, 2, and 3 are software selectable 
on the Audiotrix Pro.   

See Appendices C, D and E for more information on these 
settings. 

Chapter 2  Description of the Audiotrix Pro 
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Chapter 3 

Getting Installed 

System Requirements 

To use the Audiotrix Pro and the Audiotrix software, you 
need the following:  

1. IBM AT or compatible (80386 or higher CPU 
recommended) with a disk drive (1.4 MB 3 1/2")  

2. Available 16-bit slot 

3. 640 KB RAM (2 MB for Windows) 

4. Hard disk recommended 

5. DOS 3.1 or higher 

6. EGA or VGA (VGA recommended) 

7. Windows 3.1 or Windows 3.0 with Multimedia 
Extension (for Windows software) 

Hardware Installation 

We suggest that you read this section thoroughly before you 
begin.  This will familiarize you with the standard installation 
procedure.   
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These instructions are for installing your Audiotrix Pro in 
your computer.  We recommend that you read the owner’s 
manual supplied with your computer for instructions specific 
to your model of computer.   

Hardware Configuration Settings 

To install the Audiotrix Pro, there are two types of 
configuration settings: hardware settings and software 
settings.  The Pro uses software for most of the configuration 
settings (see the sections on installation and configuration 
below).  Only two hardware settings, made with jumpers, are 
necessary: joystick selection and microphone selection.  This 
should be made before installing the Audiotrix Pro card in 
your computer.   

Joystick Selection 

The joystick selector jumpers let the user change the factory-
set “dual joystick without MIDI” option to the “single 
joystick with MIDI” option.  All jumpers in this selector must 
be changed to the same position, as shown in Figure 2, 
page 14.   

To set a single joystick selector jumper:  

1. Locate the joystick selector jumpers (refer to 
Figure 1, No. 7, page 11).   

2. If you wish to use the Audiotrix Pro game port in the 
“dual joystick without MIDI” option, leave the 
jumpers in the factory-set position (i.e., plugged 
away from the bracket side of the card, pins No. 1–
2) as shown in Figure 2, page 14.   

3. If you wish to use the Audiotrix Pro game port in the 
“single joystick with MIDI” option, unplug all six 
jumpers and replug them onto the bracket side (pins 
No. 2-3), as shown in Figure 2, page 14.   

Chapter 3  Getting Installed 
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Microphone Selection 

The microphone selector jumpers let the user change the 
factory-set “low impedance dynamic microphone” option to 
the “electret microphone” option.  The two jumpers in this 
selector must be changed to the same position, as shown in 
Figure 3, page 15.   

To set the microphone selector jumpers:  

1. Locate the microphone selector jumpers (refer to 
Figure 1, No. 8, page 11).   

2. If you plan to use a standard low impedance dynamic 
microphone with your Audiotrix Pro, leave the 
jumpers in the factory-set position (i.e., plugged 
onto the bracket side of the card, pins No. 2–3) as 
shown in Figure 3, page 15.   

3. If you plan to use an electret microphone with your 
the Audiotrix Pro, unplug the two jumpers and replug 
them onto the opposite side (pins No. 1–2), as 
shown in Figure 3, page 15.   

WARNING:  Do not change the microphone selector 
jumpers to the “electret microphone” option (all jumpers 
on pins No. 1–2) if you plan to use a standard dynamic 
microphone.  In the “electret microphone” option, the 
microphone input connector supplies a current which 
could damage a non-electret type microphone.  On the 
other hand, if you let the microphone selector jumpers in 
the “low impedance dynamic microphone” option (all 
jumpers on pins No. 2–3), an electret type microphone will 
simply not work.   

Removing the Computer Cover 

To remove the computer cover:  

Hardware Installation 



20 

1. Switch off the computer.   
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2. Disconnect the power cord and all peripheral devices 
and cables.   

3. Set the computer on a flat, clear surface.   

4. Remove the mounting screws that hold the computer 
cover.   

5. Remove the computer cover.   

Removing the Slot Cover 

To remove the slot cover:  

1. Choose a free 16-bit slot as far as possible from the 
video adapter card.   

NOTE:  Certain cards, such as video adapters, 
produce high-frequency signals which can 
interfere with the sound quality of the sound card.   

2. Remove the screw that holds the slot cover in place.   

3. Lift the slot cover to remove it.   

WARNING:  If a screw falls into the computer, you 
absolutely must remove it before switching your system 
back on.  If a metal object is left loose inside the casing of 
your computer, it may cause a short circuit that will 
damage your system.   

Installing the Audiotrix Pro Card 

To install the Audiotrix Pro card:  

1. Place the card immediately above the slot without 
inserting it into the socket.   
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2. Make sure that the bracket is inserted in the groove 
previously occupied by the slot cover.   

3. Press the card down into the socket.   

4. Put the card’s bracket screw back on and tighten it.   

5. Put the computer cover back on and tighten the 
screws.   

6. Reconnect the power cord and other cables.   

Connecting Other Peripherals 
The card is equipped with jacks and plugs for connecting 
various peripherals.  These allow devices to be connected to:  

• Stereo Audio Output 

• Microphone Input 

• Stereo Auxiliary Input 

• MIDI/Game Port 

Stereo Audio Output 

The Audiotrix Pro card is equipped with three 1/8" jacks for 
connecting audio equipment.  The main audio output is the 
lowermost of the three jacks, located above the DB-15 
connector (refer to Figure 1, No. 5, page 11).  This jack can 
be connected to headphones, external speakers or a stereo 
system using stereo adapters and cables.  To avoid distortion 
when connecting to a stereo system, connect the card to an 
auxiliary-type input.   

Microphone Input 

The low impedance dynamic microphone/electret 
microphone input is the uppermost of the three audio jacks 
on the card’s bracket (refer to Figure 1, No. 3, page 11).  This 
connector lets the audio signal from a standard dynamic 
microphone or from an electret microphone be mixed with 
other audio sources or to be used as a source for sampling 
sounds.  (See Figure 3, page 14, for related jumper settings.)   

Hardware Installation 
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NOTE:  The microphone input impedance of the Audiotrix 
Pro card is 10 KΩ.  The dynamic microphone used should 
have a maximum impedance of 10 ΚΩ otherwise you may 
lose too much input due to an impedance mismatch.   

Stereo Auxiliary Input 

The stereo auxiliary input connector is located in the center 
of the three audio jacks on the card’s bracket (refer to 
Figure 1, No. 4, page 11).  This connector lets audio signals 
from a stereo source (such as a CD player, CD-ROM drive, 
synthesizer or cassette player) be mixed with the other audio 
sources or to be used as a source for sampling sounds.   

WARNING:  To avoid distortion, it is important to keep the 
audio level of the device you are connecting to this input 
jack at low volume and to adjust the volume using the 
software controls explained in the next chapter.  Also, 
make sure that you are using the auxiliary output of the 
device you are connecting to the card, instead of using the 
speaker output which may overload the card’s amplifier.   

MIDI/Game Port 

The Audiotrix Pro card features a standard DB-15 connector 
at the bottom of its supporting bracket (refer to Figure 1, 
No. 6, page 11).  This connector lets the user connect one of 
the following three options:  

1. An IBM compatible joystick.   

2. A MIDI device.  (This requires an adapter cable.)   

3. Dual joystick.  (This requires a special adapter, 
which is usually supplied by the joystick 
manufacturer. — See Figure 2, page 14,  for related 
jumper settings.)   
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Software Installation and Configuration 

The running and using of the Audiotrix Pro card’s drivers and 
programs require hard disk space of approximately 
2 megabytes.  They must be installed onto the hard disk 
following a precise procedure.  For this purpose, the 
Audiotrix software package includes special Install and Setup 
utility programs.  These utilities enable you to install the 
drivers and all associated programs, and to configure the 
Audiotrix Pro. 

Installing the Audiotrix Software 

The Audiotrix diskettes are not copy-protected.  We 
recommend that you make a backup copy before installing the 
software.  Put the originals away in a safe place.  This way, if 
a diskette is lost or damaged, then you will have a 
replacement.  We suggest that you use the DISKCOPY 
command.  (For all details concerning the copy commands, 
refer to your DOS manual.)   

The Install utility provided on the Audiotrix Pro diskettes 
performs the following operations:  

• Copies all files needed to run the Audiotrix Pro.   

• Edits the AUTOEXEC.BAT file.   

• Edits the WINDOWS\SYSTEM.INI configuration 
file.   

• Installs the Windows drivers if the Windows option 
was selected.   

The precise operations are all explained before beginning the 
installation by means of the INSTALL.TXT file which is 
displayed automatically on the screen. 

To Load the Install Utility 

To load the Audiotrix Pro Install utility:  

1. Insert the Setup Disk in drive A.   
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2. Set the current drive to A (or B, depending on the 
drive you are using): 

C:\>A: 

3. Load the Install utility by typing the following 
command at the DOS prompt:  

A:\>INSTALL 

The Audiotrix Pro Install utility opens, displaying the 
different install options of the Audiotrix Pro (see Figure 4).   

 

Figure 4.  Audiotrix Pro Install Utility 

To Choose Options from the Install Utility 

To select or unselect one of the software options 
from the Audiotrix Pro Install utility:  

1. Choose the software option you want by using the v 

(Tab) or j-v (Shift-Tab) keys to move between fields.   

2. After this, you can toggle between the Yes and No 
settings with the arrow keys.   

The Install utility allows choosing the following options:  
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Install DOS applications 

This option installs the files of application programs running 
under DOS: Jukepro, PLAYMIDI utility and PLAYWAVE 
utility.   

Install Windows applications 

This option installs the files of the application programs 
running under Windows: Jukebox, Audiotrix Pro Input Audio 
Mixer, Audiotrix Pro Output Audio Mixer, and Windows 
drivers.  See the next section, “Windows Audio Drivers,” for 
details.   

Install MIDI (.MID) songs 

This option installs additional MIDI song files, which can be 
played using the Jukebox or the PlayMIDI utility.   

Install Wave (.WAV) sounds 

This option installs additional sample files, which can be 
played using the Jukebox or the Playwave utility.   

Once you have chosen your install options, press the f key.  A 
status box will then appear on screen allowing you to 
continue or exit the install process.  At any moment, you can 

interrupt the install process by pressing the ̂  key.  Doing this 
will abort the installation and cancel the last step you have 
made.   

NOTE:  When interrupting the install process, files already 
copied will remain installed.  To cancel the entire 
operation, you will have to delete the unwanted copied 
files, and re-run the Install utility if so desired.  Consult the 
INSTALL.TXT and the README.TXT for the list of installed 
files and file modifications.   
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Configuring the Audiotrix Software 

Once the installation of the Audiotrix software is completed, 
you must configure your Audiotrix Pro card by using the 
Setup utility.  This Setup utility is automatically displayed on 
the screen during the installation procedure.  However, these 
setup parameters can be changed at any time after installation 
by the following procedure: 

1. Type in the drive and directory specifications that 
contain the Audiotrix Pro Setup utility:  

C:\>CD \TRXPRO 

2. Load the Setup utility by typing the following 
command at the DOS prompt:  

C:\TRXPRO>SETUPPRO 

The Audiotrix Pro Setup utility opens, displaying the 
different configuration parameters of the Audiotrix Pro 
software (see Figure 5).   

 
Figure 5.  Audiotrix Pro Setup Utility 
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To Set Configuration Parameters from the Setup 
Utility 

To set one of the configuration parameters from the 
Audiotrix Pro Setup utility:  

1. Choose the configuration parameter you want by 

using the v (Tab) or j-v (Shift-Tab) keys to move 
between fields.   

2. After this, you can change settings with the arrow 
keys.   

The Setup utility allows setting the following configuration 
parameters:  

Wave Interrupt 

Sets the wave interrupt for the Crystal chip 4231.  The default 
setting is IRQ9.   

Wave Address 

Sets the wave address for the Crystal chip 4231.  The default 
setting is 530. 

Wave DMA 

Sets the wave DMA channel for the Crystal chip 4231.  The 
default setting is DMA3.   

CD-ROM Interrupt 

Sets the optional daughterboard CD-ROM interrupt.  The 
default setting is IRQ10.  If you do not have a CD-ROM or an 
Audiotirx CD-ROM interface card, choose None. 

CD-ROM DMA Channel 

Sets the optional daughterboard CD-ROM DMA channel.  The 
default setting is DMA0.  If you do not have a CD-ROM or an 
Audiotrix CD-ROM interface card, choose None. 
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CD-ROM 16-bits Transfer 

Sets the optional daughterboard CD-ROM 16-bits transfer 
mode.  The default setting is Disabled.  If you do not have a 
CD-ROM or an Audiotrix CD-ROM interface card, choose 
Disabled. 

Sound Blaster Interrupt 

Sets the Sound Blaster interrupt.  The default setting is IRQ7. 

Sound Blaster DMA 

Sets the Sound Blaster DMA channel.  The default setting is 
DMA1.   

Sound Blaster Address 

Sets the Sound Blaster address.  The default setting is 220. 

Game Port 

Sets the game port.  The default setting is Enabled. 

MPU-401 Interrupt 

Sets the MPU-401 interrupt.  The default setting is None. 

MPU-401 Address 

Sets the MPU-401 address.  The default setting is 330. 

At any moment, you can exit the Setup utility and return to 

DOS by pressing the f key.  You then must answer the 
question “Should these parameters be used at startup?”  ”Yes” 
will enable the card settings and modify the startup parameter 
file.  “No” will only enable the settings on the card. 
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Windows Audio Drivers 

The Audiotrix Pro package includes Windows 3.1 multimedia 
drivers.  These drivers are used by several of the Windows 
utilities and software bundled with your sound card.  These 
drivers are by default installed during the installation of the 
sound card’s software (unless you unselected the 
corresponding option in order to install them separately).   

The Windows drivers may also be used by other third-party 
software developers to write multimedia programs running 
under the Windows environment.  For detailed information on 
developing multimedia applications with these drivers, please 
refer to the Mediatrix Windows Software Development Kit.   

The Windows drivers include:  

• Crystal CS31BA11 Wave Driver 1.04 

 This is a Windows driver that allows you to play back 
wave format audio files. 

• Yamaha OPL4 MIDI Synthesis Driver 

 This is a Windows driver that allows you to playback 
MIDI format files using FM, Wavetable or a 
combination of both types of sound. 

Installing the Windows Audio Drivers 

If you did not install your Windows drivers at first and you 
want to install them later, proceed as follows.   

WARNING:  To avoid any driver conflicts, you may need to 
remove any other audio drivers before installing the 
Audiotrix Pro Windows audio drivers.   

Windows Audio Drivers 
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To set up the Windows audio drivers:  

1. Start the Windows 3.1 application.   

2. From the Main program group, double-click the 
Control Panel icon.  The control panel window will 
be displayed.   

3. In the Control Panel window, double-click the 
Drivers icon.  The Drivers window will be displayed, 
showing a list of drivers currently installed in 
Windows 3.1.   

4. In the Drivers window, click the Add button.   

5. Type in the drive and directory specifications that 
contain the Audiotrix Pro Windows audio drivers:  

C:\TRXPRO\WINDOWS 

NOTE:  This drive and directory specifications assume 
you have installed the sound card’s software on drive 
C: in the TRXPRO directory.  If not, use the 
appropriate drive and directory.   

6. Click the OK button.  The Add Unlisted or Updated 
Driver window appears, showing the various 
Audiotrix Pro Windows audio drivers.   

7. Click on the Crystal CS31BA11 Wave Driver 1.04 
option, and click the OK button.  If the Driver Exists 
dialog box appears, select the New option to ensure 
proper installation.   

 Windows will now prompt you for the confirmation 
to restart you Windows application.  Click on the 
Don’t Restart Now button to return to the Drivers 
window.   

8. Repeat steps 4 and 5, then select the YAMAHA OPL4 
Midi Synthesis option and click the OK button.  If 
the Drivers Exists dialog box appears, select the 
New option to ensure proper installation.   
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9. Click the OK button.  Windows 3.1 will now prompt 
you for the confirmation to restart your Windows 
application.  Click the Restart Now button to restart 
the Windows application.   

NOTE:  For the newly installed Audiotrix Pro 
Windows audio drivers to take effect, you must restart 
Windows.  

Configuring the MIDI Mapper for the FM Synthesis 
Driver 

If you are using a Windows application that uses the MIDI 
Mapper to play .MID files, you need to select the MIDI 
Mapper for the synthesizer that will be playing the file.   

The MIDI Mapper icon should be shown in the Control 
Panel window if you have a sound card installed in your 
computer.   

To select the MIDI setup:  

1. Choose the MIDI Mapper icon to display the MIDI 
Mapper dialog box.   

2. Pull down the Name list and select the Yamaha 
OPL4 setup option.  This option serves to play 
synthesized sounds of MIDI channels out to the main 
audio output of the sound card.   

3. Choose the Close button.   

NOTE:  For more information on the MIDI Mapper, 
please refer to the Microsoft Windows User’s Guide.   
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Chapter 4 

Mixer Utilities 

The Audiotrix Pro card has an on-board analog mixer that 
permits the volume of different audio sources to be 
controlled, as well as overall output volume and balance.  
These features can be accessed using the Audiotrix Pro Mixer 
or the Audiotrix Pro TSR Mixer (DOS utilities), and the 
Audiotrix Pro Input Mixer and the Audiotrix Output Mixer 
(Windows utilities).   

Audiotrix Pro Mixer 

The Audiotrix Pro Mixer is a small utility program that 
permits you to set the volume of different audio sources, as 
well as the overall output volume and balance of the Audiotrix 
Pro card.   

Loading the Audiotrix Pro Mixer 

To load the Audiotrix Pro Mixer, set the current directory to 
the one where you placed the utility at installation and type 
the following command:  

C:\TRXPRO>MIXERPRO 

Upon loading, the Audiotrix Pro Mixer will appear as shown 
in Figure 6.   
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Figure 6.  Audiotrix Pro Mixer 

Using the Audiotrix Pro Mixer 

To change the volume settings on the Audiotrix Pro 
Mixer:  

1. Select the item you want using the v (Tab) or j-v 
(Shift-Tab) keys.   

2. After this, you can change the chosen item in one of 
the following ways:  

• Increase the value of the chosen item by using the 
up or right arrow keys (w or x).   

• Decrease the value of the chosen item by using 
the down or left arrow keys (y or z).   

The following describes the features of the Audiotrix Pro 
Mixer.   

Monitor 

Sets the digital audio monitor volume of the Crystal chip 
4231. 
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Wave Out Left 
Wave Out Right 

Sets the wave left and right volume of the Crystal chip 4231.   

CD/Line Out Left 
CD/Line Out Right 

Sets the CD/Line left and right volume. 

Sound Blaster 

Sets the Sound Blaster speech/effects volume.   

Music Out Left 
Music Out Right 

Sets the music/synthesis volume of the Yamaha OPL4 
synthesizer. 

Microphone Left 
Microphone Right 

Sets the left and right microphone volume. 

Mute 

Mutes the corresponding source.  

Master Mute 

Mutes all outputs. 

Exiting the Audiotrix Pro Mixer 

To exit the Audiotrix Pro Mixer:  

Audiotrix Pro Mixer 
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• Press the f key to leave the utility program and 
return to DOS.   
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Audiotrix Pro TSR Mixer 

The Audiotrix Pro TSR Mixer is a simple TSR utility that 
permits you to change the master volume and balance of the 
Audiotrix Pro card at anytime while you are in an application.   

TSR stands for Terminate-and-Stay Resident program, 
which is also called a memory resident program.  It is a 
utility program designed to remain in the computer’s 
memory at all times after loading so the user can activate it 
with a keystroke at any time, even while running another 
program.   

Loading the Audiotrix Pro TSR Mixer 

To load the Audiotrix Pro TSR Mixer, set the current 
directory to the one where you placed the utility at 
installation and type the following command:  

C:\TRXPRO\DOS>MIXTSR 

When the Audiotrix Pro TSR Mixer is loaded, it will display a 
message indicating that the utility has been successfully 
loaded.  It will also indicate which keys must be used to 
activate the Audiotrix Pro TSR Mixer.   

Activating the Audiotrix Pro TSR Mixer 

a-M are the default activation keys for activating the 
Audiotrix Pro TSR Mixer.  In order to avoid conflicts with 
other programs, you may change the combination of keys 
used to activate the Audiotrix Pro TSR Mixer by using the 
following command:  

C:\TRXPRO\DOS>MIXERTSR/Kx/KALT 
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You can replace the x character with any character from A to 
Z, and you can replace ALT with CONTROL as the modifier 
key.   

To activate the Audiotrix Pro TSR Mixer, press the activation 
keys down at the same time and release them.  Upon releasing 
the keys, the utility will appear on screen as shown in 
Figure 7.   

 
Figure 7.  Audiotrix Pro TSR Mixer 

This TSR can be activated at any time with applications 
supporting the Audiotrix Pro.  The screen will be returned to 
its original state when you exit the Mixer window.   

NOTE:  The Audiotrix Pro TSR Mixer will be displayed 
only in text mode.  If you activate the Audiotrix Pro TSR 
Mixer while in graphics mode, keys will still work, even 
though the screen will not be displayed.   

Audiotrix Pro TSR Mixer 
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Using the Audiotrix Pro TSR Mixer 

To change the volume settings while in the Audiotrix 
Pro TSR Mixer:  

• Press U for left master volume up.   

• Press D for left master volume down.   

• Press M or k for left master volume mute.   

• Press j-U for right master volume up.   

• Press j-D for right master volume down.   

• Press j-M or j-k for right master volume mute.   

Exiting the Audiotrix Pro TSR Mixer 

To exit the Audiotrix Pro TSR Mixer:  

• Press the ̂  key to leave the Audiotrix Pro TSR 
Mixer and return to where you were when the TSR 
utility was activated.   

Unloading the Audiotrix Pro TSR Mixer 

When the Audiotrix Pro TSR Mixer is already installed but 
you no longer wish to use it, you can unload the program by 
typing the following command:  

C:\TRXPRO\DOS>MIXTSR 

Once this command is entered, the program will display a 
message indicating that the Audiotrix Pro TSR Mixer has 
been removed from the computer’s memory.   
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Audiotrix Pro Input/Output Mixers 

The Audiotrix Pro Input Mixer and the Audiotrix Pro Output 
Mixer are small Windows utilities that permit you to set the 
volume of different audio sources, as well as the overall 
output volume and balance of the Audiotrix Pro card.   

Using the Audiotrix Pro Input Mixer 

To load the Audiotrix Pro Input Mixer, go to the Mediatrix 
program group in Windows and choose the following icon:  

 

Upon loading, the Audiotrix Pro Input Mixer will appear as 
shown in Figure 8.   

 
Figure 8.  Audiotrix Pro Input Mixer 

Audiotrix Pro Input/Output Mixers 
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The following describes the features of the Audiotrix Pro 
Input Mixer.   

About 

Clicking this button brings up a dialog window describing the 
utility and its version.   

Mixer 

Clicking this button spawns the Audiotrix Pro Output Mixer.  
The path to, and name of the output mixer must be located in 
the APPLETS section of CS31BA11.INI.   

Save 

Clicking this button saves the current settings to the 
CS31BA11.INI file to be used as initial settings when 
Windows is loaded.   

OK 

Clicking this button exits the Audiotrix Pro Input Mixer and 
keeps the current device settings.   

Cancel 

Clicking this button exits the Audiotrix Pro Input Mixer and 
restores the values which were present when the utility was 
opened.  If the values have been saved while in the utility, then 
restores the values which were saved.   

Input volume 

This slider allows setting the input gain for the source 
specified in the Input Selector section.  Each channel can be 
controlled separately by unchecking the Gang box.   

Chapter 4  Mixer Utilities 



43 

Gang 

Clicking this button allows the slider pair to be adjusted 
individually or in unison.   

Line 

Clicking this option selects the music level input.   

Aux 

Clicking this option selects the CD input.   

Loop 

Clicking this option selects the internal loop back input.   

Mic 

Clicking this option selects the microphone input.   

Boost 

When checked, this option adds 20 dB additional gain to the 
microphone input.   

Dither 

This option allows turning on and off dither for 8-bit PCM 
audio.   

VU On 

When selected, this option allows monitoring the selected 
input on the Volume Meter.   

Vrms/db 

Clicking this button toggles the Full Scale window between 
Vrms and dB modes.  The Full Scale window shows the input 
signal amplitude which will cause clipping at the D/A 
converter.   

Audiotrix Pro Input/Output Mixers 
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Using the Audiotrix Pro Output Mixer 

To load the Audiotrix Pro Output Mixer, go to the Mediatrix 
program group in Windows and choose the following icon:  

 

Upon loading, the Audiotrix Pro Output Mixer will appear as 
shown in Figure 9.   

 
Figure 9.  Audiotrix Pro Output Mixer 

The following describes the features of the Audiotrix Pro 
Output Mixer.   

About 

Clicking this button brings up a dialog window describing the 
utility and its version.   
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Inputs 

Clicking this button spawns the Audiotrix Pro Input Audio 
Mixer.  The path to, and name of the input mixer must be 
located in the APPLETS section of CS31BA11.INI.   

Save 

Clicking this button saves the current settings to the 
CS31BA11.INI file to be used as initial settings when 
Windows is loaded.   

OK 

Clicking this button exits the Audiotrix Pro Output Audio 
Mixer and keeps the current device settings.   

Cancel 

Clicking this button exits the Audiotrix Pro Output Audio 
Mixer and restores the values which were present when the 
utility was opened.  If the values have been saved while in the 
utility, then restores the values which were saved.   

Monitor Atten 

This slider allows setting the monitor volume.   

Wave Atten 

This slider allows setting the left and right output volume for 
the wave source.   

Sound Blaster 

This slider allows setting the volume for the Sound Blaster 
output.   

Music Mix 

This slider allows setting the volume for the OPL4 
synthesizer. 
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CD/Line Mix 

This slider allows setting the volume for the CD/Line source.   

Mic Mix 

This slider allows setting the volume for the microphone 
source.   

Gang 

Clicking this button allows the slider pair to be adjusted 
individually or in unison.   

Mute 

When checked, this option mutes the corresponding source.   

Mono Mute 

When checked, this option mutes the mono output.   

Monitor when Recording Only 

When checked, this option enables the monitor loop back 
only when capturing data.  This is a convenient feature when 
recording source material.  It allows hearing the material 
being recorded and then, when playing back, the source is not 
heard.   
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Chapter 5 

Playback Utilities 

The Audiotrix software includes three playback utility 
programs that can be used with the Audiotrix Pro card:  

• Jukebox Playback Program 

• PLAYMIDI Utility 

• PLAYWAVE Utility 

Jukebox Playback Program 

Jukebox is a playback program specially designed to use the 
sound capabilities of the Audiotrix Pro card.  It enables you 
to play MIDI song files and samples provided with the card, 
or any .MID and .WAV files you want from a music clip 
library, and CD musical selections from an audio CD. 

Loading Jukebox 

To load the Jukebox playback program under DOS, set the 
current directory to the one in which you placed the Jukebox 
at installation and type:  

C:\TRXPRO\DOS>JUKEPRO 

NOTE:  Using the Jukebox playback program under DOS 
requires HIMEM.SYS or equivalent.   
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To load the Jukebox playback program under Windows, go to 
the Mediatrix program group in Windows and choose the 
following icon:  

  

Once the program is loaded, the Jukebox window wi ll appear 
as shown in Figure 10.   

 

Figure 10.  Audiotrix Jukebox 

This window displays the various menu titles and command 
buttons (see Figure 10).  Other possible options are 
contained in the menus.  To activate a menu or command, use 
one of the following methods:  

• Using a mouse: To activate the menu or command 
you want, click the menu or button command with 
the mouse.   

• Using the keyboard shortcuts: To activate the menu 
or command you want, press the a key and the letter 
underlined in its name.  To activate a command in an 
open menu, press the underlined letter.   
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Selecting Songs 

The Jukebox window contains two large boxes for music file 
selection.  The box located at the left of the screen, entitled 
Files to Select, displays the contents of current directory.  
This is a list of files, subdirectories and drives through which 
you can navigate by selecting the appropriate name and 

pressing the e key, or by double clicking with the mouse.  
The name of the current directory is displayed above the box 
at the left.  When the program is loaded, the default directory 
is the directory where the Jukebox program is located. 

The box at the right of the screen, entitled Files to Play, 
displays the selection of files that will be played.   

To Create a Selection of Music Files 

To create a selection of music files, go to any directory 
containing MIDI (.MID) files or digitized sound (.WAV) 
files, highlight the file and click the  button, 

or press a-I, or press e, or double click with the mouse, for 
each music file you wish to add to the selection.  As each 
music file is selected, its DOS file name will be displayed in 
the Files to Play box at the right of the screen in its order of 
selection.  You may select as many music files as you wish.  
If you want to add a CD track, choose CD Track to Play from 
the List menu at the top of the screen. 

To Remove Music Files from the Selection 

The box at the right of the screen displays the list of music 
files contained in the selection you have made.  To remove a 
music file from the selection, highlight its name and click the 

 button, or press a-D, or press e, or double 
click with the mouse.   

Jukebox Playback Program 
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To Clear a Music File Selection 

To remove all the music files contained in the selection at 

once, simply click the  button, or press a-A.   

To Save a Music File Selection 

To save a music file selection you just created:  

1. Choose the Save As command from the File menu.  
A dialog box will open on the screen prompting you 
to name your selection file.   

2. Enter the name you want for your selection file, 
making sure you specify .JUK as the DOS extension.  
The default selection file furnished with the Jukebox 
program is entitled DEMODOS1.JUK or 
DEMOWIN1.JUK.   

3. If necessary, change the current directory, 
subdirectory and/or drive using the directory paths.   

4. Click OK or press e to confirm your choice.  The 
selection file will be saved under the name you have 
entered.   

To save changes you made to a selection file already named:  

n Choose the Save command from the File menu.  If the 
selection file has already been named, it will 
automatically be saved.  If not, the program will open 
the Save As dialog box prompting you to name your 
selection file (see above).   

To Open a Music File Selection 

To open an existing selection file:  

1. Choose the Open command from the File menu.  A 
dialog box will open on the screen listing the .JUK 
files in the current directory.   
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2. Choose a .JUK file from this list, or open another 
directory, subdirectory and/or drive and choose a 
.JUK file from that directory.  You can also type the 
file name directly into the edit field.   

3. Click OK or press e to confirm your choice.  This 
will close any open selection file to make room for 
the new one.   

To create a new selection file:   

1. Choose the New command from the File menu.  This 
will close any open file and will open an empty and 
untitled selection file.   

2. Create your selection of music files as explained 
above.   

3. Save your music file selection under a new name 
with the Save As command from the File menu 
(see above).   

Playing Music Files 

The commands for playing back music files are found in the 
Control bar located at the upper right corner of the screen, 
and in the Control menu.  The standard playback buttons can 
be activated by using the following method:  

• Using a mouse: Click the button command you want 
with the mouse.   

To Play Music Files 

To play your selection of music files, activate the Play button 

( ), or press a-P.  Each music file in the Files to Play 
list will be played in order.  Once the music begins  

Jukebox Playback Program 
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playing, the name of the music file currently playing is 
highlighted in the list.  If you highlight a music file in the 
Files to Play list prior to activating the Play button, then the 
list will be played from the highlighted music file (the 
previous music files will be played at the end however).   

To repeat continuously the playback of your selection of 
music files, choose Repeat from the Options menu.   

To play and repeat continuously your selection of music files 
in a random order, choose Shuffle from the Options menu.   

To Stop Playback 

To stop music playback, activate the Stop button ( ), or 

press a-S.   

To Pause and Resume Playback 

To pause music playback, activate the Pause button ( ), 

or press a-U.  When the music pauses, the Pause button is 
grayed out.   

To continue music playback at the exact place where it 
stopped, re-activate the Pause button.  Once the music starts 
up again, the Pause button is no longer grayed out.   

To Scan Music Files 

To skip to the next music file during playback, activate the 

Next button ( ), or press a-N.  This will immediately 
start the next music file in the selection list if there are any 
left.   

To return to the previous music file during playback, activate 

the Previous button ( ), or press a-R.  This will 
immediately start the previous music file.   

Chapter 5  Playback Utilities 
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Asking for Help 

When you choose the Help command from the Help menu, a 
window opens up on the screen containing summarized 
information on how to operate the Jukebox program and how 
to use the various features.   

Choosing the About command from the Help menu opens a 
window giving the date and version number of the Jukebox 
program.   

Exiting the Jukebox Program 

To leave the program and return to DOS, use one of the 
following methods:  

• Activate the Exit command from the File menu.   

 OR 

• Click on the System menu box at the upper left 
corner of the window and activate the Close 
command.   

PLAYMIDI Utility 

The PLAYMIDI utility is a small program that allows the user 
to play MIDI files from the DOS command line or from a 
batch file.   

The format of the command running the PLAYMIDI utility is 
the following:  

PLAYMIDI <FileName>.MID 

Jukebox Playback Program 
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Where <FileName> is the complete name (including drive 
and path) of the MIDI file (.MID) to be played, i.e.: 

PLAYMIDI C:\TRXPRO\MIDI\BLUES.MID 

If you enter “PLAYMIDI” alone, the program displays help 
lines giving summarized information on program parameters.   

PLAYWAVE Utility 

The PLAYWAVE utility is a small program that allows to play 
back digitized sound files (recorded in the .WAV format) 
from the DOS command line or from a batch file.  The 
program features direct-to-disk capabilities that allows 
playing unlimited file size.   

The format of the command running the PLAYWAVE utility 
is the following:  

PLAYWAVE <FileName>.WAV 

Where <FileName> is the complete name (including drive 
and path) of the digitized sound file (.WAV) to be played, i.e.: 

PLAYWAVE C:\TRXPRO\WAVE\INTRO.WAV 

If you enter “PLAYWAVE” alone, the program displays help 
lines giving summarized information on program parameters.   
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Appendix A 

Troubleshooting 
In this appendix, you will find solutions to problems you may 
encounter when installing and using the Audiotrix Pro Card.  
The following list of usual problems is addressed in detail 
afterwards.   

Usual Problems 
1. The Setup utility seems to indicate that the Audiotrix 

Pro card is properly installed but does not produce 
any sound.   

2. When trying to save a sample created with a 
sampling program, the computer locks up.   

3. The serial mouse does not work properly with the 
Audiotrix Pro card installed.   

4. The FM synthesis, MIDI, or sampling does not work.   

5. When running software for the Audiotrix Pro card, 
the computer hangs.   

6. The FM synthesis and the digital sampling work fine, 
but the MIDI does not work.   

7. The joystick does not work.   

8. Hard disk or floppy disk does not work when the 
Audiotrix Pro card is present in the computer.   

9. When recording with a microphone, the level is too 
low.   

10. The sound is distorted when recording from a CD 
player or other electronic audio device.   



56 

1. Problem:  

The Setup utility seems to indicate that the Audiotrix Pro card 
is properly installed but does not produce any sound.   

Possible cause:  

• The headphones, external speakers or stereo system 
are incorrectly connected.   

• The volume in the mixer is set too low.   

• There is no musical program running.   

Solution:  

• Make sure that all connectors are securely inserted.   

• Disconnect any external loudspeaker or stereo 
system and try the card with  headphones.   

• Open the mixer (type MIXERPRO from 
C:\TRXPRO) and make sure that the volume is set 
high enough.   

• Type TEST from the C:\TRXPRO directory to check 
the new settings. 

2. Problem:  

When trying to save a sample created with a sampling 
program, the computer locks up.   

Possible cause:  

• The controller card for the hard disk is using the same 
DMA channel as the Audiotrix Pro card.   

Appendix A  Troubleshooting 
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Solution:  

• Run the Setup utility (type SETUPPRO from 
\TRXPRO) and change the setting of the DMA 
channel for the wave part of the card.  (Be aware that 
DMA channel 3 is frequently used by the hard drive 
controller card.)   

3. Problem:  

The serial mouse does not work properly with the Audiotrix 
Pro card installed.   

Possible cause:  

• The serial mouse is using the same interrupt line as 
the Audiotrix Pro card.   

Solution:  

• Run the Setup utility (type SETUPPRO from 
\TRXPRO), then change the IRQ interrupts.  Note that 
COM2, which is used quite often by a mouse or a 
modem, is frequently assigned to IRQ3, and COM1 to 
IRQ4.   

4. Problem:  

The FM synthesis, MIDI, or sampling does not work.   

Possible cause:  

• This problem could be caused by a parallel printer 
port which is using hardware IRQ7.  The Audiotrix 
Pro card can share this interrupt with the parallel 
printer in most cases.  However, on some PCs the 

Usual Problems 
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parallel port may prevent the Audiotrix Pro card from 
receiving this interrupt.   
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Solution:  

• Run the Setup utility (type SETUPPRO from 
\TRXPRO), then change the IRQ interrupts.   

5. Problem:  

When running software for the Audiotrix Pro card, the 
computer hangs.   

Possible cause:  

• This could be caused by an interrupt or port address 
conflict with another board.   

Solution:  

• Remove the drivers for all the boards, and reinstall 
them one by one, trying the application every time 
until the conflict occurs.   

6. Problem:  

The FM synthesis and the digital sampling work fine, but the 
MIDI does not work.   

Possible cause:  

• The software does not support the MIDI interface.   

• The joystick selector jumpers are not set properly.   

• The MIDI cables are not properly connected.   

• The MIDI interface is not set to the proper port 
address or interrupt.   

• The appropriate drivers are not loaded.   

Appendix A  Troubleshooting 
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Solution:  

• Make sure that the MIDI software does support the 
Audiotrix Pro card.  If not certain, you should contact 
the manufacturer.   

• Set the joystick selector jumpers in the “single 
joystick with MIDI” position.  Refer to the section 
“Hardware Installation: Hardware Configuration 
Settings” in Chapter 3, for the complete procedure.   

• The MIDI cables should not be inverted, the MIDI Out 
of the interface must go into the MIDI In of the 
device, and vice versa.   

• If the port address or interrupts must be changed, run 
the Setup utility.   

• Make sure that the appropriate drivers are loaded for 
the MIDI application.   
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7. Problem:  

The joystick does not work.   

Possible cause:  

• The joystick selector jumpers on the Audiotrix Pro 
card are improperly set.   

• You are trying to use a joystick with another game 
card.   

• You are trying to use the game port on the Audiotrix 
Pro card with another game card installed.   

Solution:  

• Set the joystick selector jumpers in the position 
corresponding to the joystick (single or dual) you are 
using.  Refer to the section “Hardware Installation: 
Hardware Configuration Settings” in Chapter 3, for 
the complete procedure.   

• If you want to use your former game card, you must 
disable the game port on the Audiotrix Pro card.  To 
do this, run the Setup utility (type SETUPPRO from 
\TRXPRO), then set the Game Port parameter to 
“Disabled.”   

• Should you want to use the game port on the 
Audiotrix Pro card, then you should remove the 
conflicting game card or disable it if possible.   

Appendix A  Troubleshooting 



62 

8. Problem:  

Hard disk or floppy disk does not work when the Audiotrix 
Pro card is present in the computer.   

Possible cause:  

• The hard disk or floppy disk is using the same DMA 
channel as the Audiotrix Pro card.   

Solution:  

• To change a DMA channel used by the Audiotrix Pro 
card, run the Setup utility (type SETUPPRO from 
\TRXPRO) and set the appropriate parameter.  If no 
DMA channels are available for the Audiotrix Pro 
card, you can choose a configuration that lets you use 
the audio and the SCSI (CD-ROM) by interrupt.   

9. Problem:  

When recording with a microphone, the level is too low.   

Possible cause:  

• The microphone is not properly connected or it is 
connected to the wrong connector on the card.   

• The microphone input impedance of the Audiotrix 
Pro card is 10 ΚΩ.  The dynamic microphone used 
should have a maximum impedance of 10 ΚΩ 
otherwise you may lose too much input due to an 
impedance mismatch.  
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NOTE:  The impedance is the equivalent of the 
electrical resistance in a circuit.  The impedance of the 
source should be smaller than the impedance of the 
input it is feeding, in order not to reduce the voltage 
involved, thus the output level.   

• The microphone input level is too low.   

Solution:  

• Make sure that the microphone is correctly plugged 
into the microphone input on the card (No. 3 on 
Figure 1, page 11), and not the auxiliary input (No. 4) 
nor the audio output (No. 5).   

• If possible, try another microphone.   

• Go into the input mixer (Audiotrix Pro Input Mixer 
for Windows) and increase the microphone input 
level.  You may also check the Boost option.  When 
checked, this option adds 20 dB additional gain to the 
microphone input.   
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10. Problem:  

The sound is distorted when recording from a CD player or 
other electronic audio device.   

Possible cause:  

• The output of the audio device is plugged into the 
microphone input rather than the auxiliary input.   

• The input level is set too high.   

Solution:  

• Make sure that the audio device is correctly plugged 
into the auxiliary input on the card (No. 4 on Figure 1, 
page 11), and not the microphone input (No. 3) nor 
the audio output (No. 5).   

• Go into the input mixer (Audiotrix Pro Input Mixer 
for Windows) and decrease the CD input level.   

Technical Support 

Each Audiotrix Pro card is systematically checked prior to 
shipping in order to ensure that it is free from technical 
problems.  However, if you encounter a problem that you are 
not able to solve after following the directions in this guide, 
do not hesitate to call our technical support department.  Our 
technical support number is: (800) 820-TRIX.  You will need 
the following information on hand when you call:  

• the serial number located on the back of your 
Audiotrix Pro card;  

• this User’s Guide.   
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Appendix B 

Technical Specifications 

In this appendix, you will find a general reference guide that 
details the capabilities of the Audiotrix Pro card, and the 
parameter values of its different components.   

Stereo Wave Table and FM Synthesizer by Yamaha 

• Wave Table Synthesizer 

• Stereo output of up to 24 simultaneous Wave Table 
voices with 16 levels of pan for each voice 

• Sampling frequency of voice data is 44.1 KHz 

• Waveform data length is 8-, 12- or 16-bit 

• 2 megabytes ROM standard general MIDI voice bank 
including 128 melodic sound and 47 percussive 
sounds 

 

• Advanced Algorithm FM Synthesizer 

• Stereo sound generators 

• Register compatible with YM3812 synthesizer LSI 

• 18 simultaneous instrument sounds, or 15 
instruments and 5 drum sounds 

• Eight modulation waveforms 

• Four additional algorithms 
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• Low frequency oscillator (LFO) for vibrato and 
tremolo effects 

• Two programmable timers 

• Faster register access than YM3812 with an 
architecture that is optimized for the new PC BUS  

• CMOS low power technology 

Stereo Digital-to-Audio Converter by Yamaha 

• YAC513 stereo serial 16-bit DAC 

Stereo Multimedia Audio 16-bit Codec by Crystal 

• CS4231 Parallel Interface, Multimedia Audio 
Codec 

• Stereo 16-bit audio record 

• Stereo 16-bit audio playback 

• Selectable PCM (16-bit) or compressed ADPCM (4-
bit) modes with 4:1 compression on record and 
playback 

• Supports variable sampling rates (44.1 KHz, 22.05 
KHz, 11.025 KHz, 5.5125 KHz, and 12 other) 

• 16 byte FIFO’s on record and playback channels 

• Selectable CPU (polling interrupt) mode and DMA 
mode 

• One or two DMA channels (for multiplexed stereo 
data path or individual DMA assigned to the L and R 
channels) 

• Hardware timers for audio/visual synchronization 

Stereo Wave Table and FM Synthesizer by Yamaha 
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• Software selectable DMA (0, 1, 2, 3) and IRQ (3, 4, 
5, 7, 9, 10, 11, 12, 15) 

• Selectable I/O addresses (530, 604, E80, F40) 

• CMOS low power technology 

Appendix B  Technical Specifications 
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Appendix C 

Standard IRQ Usage 
An IRQ (interrupt request line) is a signal path that leads from 
a hardware device through an interrupt controller to the CPU.  
For example, the keyboard generates an IRQ every time you 
press or release a key.  The following is a list of standard IRQ 
assignments for IBM AT compatible computers. 

AT (80286, 386 and 486 Computers) 
IRQ Usage 

0 System Timer 
1 Keyboard 
2 Cascade IRQ8 Through IRQ15 
3 COM2 (selectable for SB) 
4 COM1 (selectable for SB) 
5 LPT2 (selectable for SB) 
6 Floppy-Disk Controller 
7 LPT1 (sharable) (selectable for SB, Wave) 

(SB default) 
8 Real Time Clock 
9 Redirected as IRQ2 (selectable for Wave) 

(Wave default) 
10 Available (selectable for Wave) 
11 Available (selectable for Wave) 
12 Available (PS/2 Mouse) 
13 Math Coprocessor 
14 Hard-Disk Controller 
15 Unassigned 
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Appendix D 

Standard I/O Ports 
I/O addresses are the pathways the CPU uses to communicate 
with peripheral devices and controllers.  Most of the available 
I/O ports are reserved for standard assignments to such 
devices as the keyboard, timers, and video cards.  Add-in 
sound cards that need I/O addresses have only a few from 
which to choose.  The following is a partial list of the 
standard I/O port assignment for sound cards on IBM 
compatible computers. 

AT (80286, 386 and 486 Computers) 
    I/O Address Usage 
Sound 200 Selectable for SB 
Blaster 210 Selectable for SB 

 220 Selectable for SB (Default) 
 230 Selectable for SB 
 240 Selectable for SB 
 250 Selectable for SB 
 260 Selectable for SB 
 270 Selectable for SB 
   

MIDI 330 Selectable for MPU-401 
(Default) 

 370 Selectable for MPU-401 
 3B0 Selectable for MPU-401 
 3F0 Selectable for MPU-401 
   

Wave 530 Selectable for Wave (Default) 
 604 Selectable for Wave  
 E80 Selectable for Wave  
 F40 Selectable for Wave  
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Appendix E 

Standard DMA Usage 

The DMA (direct memory access) controller is used to move 
blocks of data quickly from one memory address to another 
or between memory and an I/O port without going through the 
computer’s CPU.  An XT compatible computer has four DMA 
channels, of which three are reserved by the system.  An AT 
compatible computer has eight DMA channels and reserves 
only two for the standard system.  The following is a list of 
the standard DMA assignments for IBM AT compatible 
computers. 

AT (80286, 386 and 486 Computers) 

DMA 
Channel 

 
Usage 

0 Selectable for Wave  
1 Selectable for SB, Wave (SB default) 
2 Floppy-Disk Controller 
3 Selectable for SB, Wave (Wave default) 
4 Cascade DMA0 Through DMA3 
5 Unassigned 
6 Unassigned 
7 Unassigned 
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 Appendix F 

General MIDI Patches 
1 Acoustic Grand Piano 
2 Bright Acoustic Piano 
3 Electric Grand Piano 
4 Honky-Tonk Piano 
5 Electric Piano 1 
6 Electric Piano 
7 Hapsichord 
8 Clavi 
9 Celesta 
10 Glockenspiel 
11 Music Box 
12 Vibraphone 
13 Marimba 
14 Xylophone 
15 Tubular Bells 
16 Dulcimer 
17 Drawbar Organ 
18 Percussive Organ 
19 Rock Organ 
20 Church Organ 
21 Reed Organ 
22 Accordion 
23 Harmonica 
24 Tango Accordion 
25 Acoustic Guitar (Nylon) 
26 Acoustic Guitar (steel) 
27 Acoustic Guitar (Jazz) 
28 Acoustic Guitar (Clean) 
29 Acoustic Guitar (Muted) 
30 Overdriver Guitar 
31 Distortion Guitar 
32 Guitar Harmonics 
33 Acoustic Bass 
34 Electric Bass (Finger) 
35 Electric Bass (Pick) 

36 Fretless Bass 
37 Slap Bass 1 
38 Slap Bass 2 
39 Synth Bass 1 
40 Synth Bass 2 
41 Violin 
42 Viola  
43 Cello 
44 Contrabass 
45 Tremolo Strings 
46 Pizzicato Strings 
47 Orchestral Harp 
48 Timpani 
49 String Ensemble 1 
50 String Ensemble 2 
51 Synth Strings 1 
52 Synth Strings 2 
53 Choir Aahs 
54 Voice Oohs 
55 Synth Voice 
56 Orchestra Hit 
57 Trumpet 
58 Trombone 
59 Tuba 
60 Muted Trumpet 
61 French Horn 
62 Brass Section 
63 Synth Brass 1 
64 Synth Brass 2 
65 Soprano Sax 
66 Alto Sax 
67 Tenor Sax 
68 Baritone Sax 
69 Oboe 
70 English Horn 
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71 Bassoon 
72 Clarinet 
73 Piccolo 
74 Flute 
75 Recorder 
76 Pan Flute 
77 Blown Bottle 
78 Shakuhachi 
79 Whistle 
80 Ocarina  
81 Lead 1 (Square) 
82 Lead 2 (Sawtooth) 
83 Lead 3 (Calliope) 
84 Lead 4 (Chiff) 
85 Lead 5 (Charang) 
86 Lead 6 (Voice) 
87 Lead 7 (Fifths) 
88 Lead 8 (Bass + Reed) 
89 Pad 1 (New Age) 
90 Pad 2 (Warm) 
91 Pad 3 (Polysynth) 
92 Pad 4 (Choir) 
93 Pad 5 (Bowed) 
94 Pad 6 (Metallic) 
95 Pad 7 (Halo) 
96 Pad 8 (Sweep) 
97 FX1 (Rain) 
98 FX2 (Soundtrack) 
99 FX3 (Crystal) 
100 FX4 (Atmosphere) 
101 FX5 (Brightness) 
102 FX6 (Goblins) 
103 FX7 (Echoes) 
104 FX8 (Sci-Fi) 
105 Sitar 
106 Banjo 
107 Shamisen 
108 Koto 
109 Kalimba 
110 Bagpipe 
 

111 Fiddle 
112 Shanai 
113 Tinkle Bell 
114 Agogo 
115 Steel Drums 
116 Woodblock 
117 Taiko Drum 
118 Melodic Tom  
119 Synth Drum 
120 Reverse Cymbal 
121 Guitar Fret Noise 
122 Breath Noise 
123 Seashore 
124 Bird Tweet 
125 Telephone Ring 
126 Helicopter 
127 Applause 
128 Gunshot 
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